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1 Preface

Openl Tablets is a Business Rules Management System (BRMS) based on tables presented in Microsoft Excel
documents. Using unique concepts, OpenlL Tablets facilitates treating business documents containing business
logic specifications as an executable source code.

Openl Tablets provides a set of tools addressing BRMS related capabilities including OpenL Tablets WebStudio
that can be used for creating, testing, and managing business rules and business rule projects, and OpenL
Tablets Web Services designed for integration of business rules into customer applications.

The OpenL Tablets Installation Guide provides instructions for installing and customizing OpenL Tablets
software. The document describes how to install OpenL Tablets under Apache Tomcat, deploy, and set up OpenL
Tablets Web Services.

This section includes the following topics:

e How This Guide Is Organized
e Audience

e Related Information

e Typographic Conventions

1.1 How This Guide Is Organized

Information on how to use this guide

Section Description
Before You Begin Lists system requirements for installing and using OpenL Tablets software.
Install OpenL Tablets WebStudio under Explains how to install OpenL Tablets WebStudio under Apache Tomcat.

Apache Tomcat

Deploy Openl Tablets Web Services under  Designed for rule developers who need to use business rules as separate
Apache Tomcat web services.

Install OpenL Tablets WebStudio and Explains how to install OpenL Tablets WebStudio and OpenL Tablets Web
Openl Tablets Web Services on Services on WebSphere Application Server.

WebSphere Application Server

Openl Tablets WebStudio and OpenL Explains how to set up OpenlL Tablets WebStudio and OpenL Tablets Web
Tablets Web Services Integration Services as an integrated environment.

e Troubleshooting Notes Provides useful information related to OpenL Tablets installation.

e Frequently Asked Questions

1.2 Audience

This guide is mainly targeted at business users and rule experts who define, view, and manage their business
rules and rule projects via OpenL Tablets WebStudio. Developers can also use this document to learn how to
install and set up OpenL Tablets Web Services.

Basic knowledge of Java and Apache Tomcat is required to use this guide effectively.

© 2004-2020 Openl Tablets
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1.3 Related Information

The following table lists sources of information related to contents of this guide:

Related information

Title Description

[Openl Tablets WebStudio User Guide] Describes OpenL Tablets WebStudio, a web application for managing
Openl Tablets projects through web browser.

[OpenL Tablets Reference Guide] Provides overview of OpenlL Tablets technology, as well as its basic
concepts and principles.

http://openl-tablets.org/ Openl Tablets open source project website.

1.4 Typographic Conventions

The following styles and conventions are used in this guide:

Typographic styles and conventions

Convention Description

Bold e Represents user interface items such as check boxes, command buttons, dialog boxes,
drop-down list values, field names, menu commands, menus, option buttons, perspectives,
tabs, tooltip labels, tree elements, views, and windows.

e Represents keys, such as F9 or CTRL+A.
e Represents a term the first time it is defined.

Courier Represents file and directory names, code, system messages, and command-line commands.
Courier Bold Represents emphasized text in code.
Select File > Save As Represents a command to perform, such as opening the File menu and selecting Save As.
Italic e  Represents any information to be entered in a field.

e Represents documentation titles.
<> Represents placeholder values to be substituted with user specific values.
Hyperlink Represents a hyperlink. Clicking a hyperlink displays the information topic or external source.
[name of guide] Reference to another guide that contains additional information on a specific feature.

© 2004-2020 Openl Tablets
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2 Before You Begin

The following table covers system requirements for installing and running OpenL Tablets software:

Software requirements

Software Requirements description

Operating systems One of the following:
e  Microsoft Windows 7+ x86/64
e Ubuntu 12.x
e Linux 3.x

Note: Openl Tablets software can potentially run on any operating system that supports Java
Virtual Machine, e.g. Mac OS. This table lists operating systems on which the OpenL
Tablets software is tested and supported.

Browsers One of the following:

e  Microsoft Internet Explorer 11.x
e  Firefox 60 ESR or later
e Chrome 73+

Data Bases One of the following:
e MySQL 5.5+
e MariaDB 10.2+
e MSSQL Server 2008+
e Oracle 11g +
e  PostgreSQL 9.5+
Other software e Java 8/11/12 x86/64
e Apache Tomcat 7, 8.5,9
e WebSphere Application Server 8.5
e JBossEAP7.1
Hardware requirements
e RAM 4 GB minimum.
6 GB is recommended.
e 1 GHz or faster 32-bit (x86) or 64-bit (x64) processor.
User rights requirements

Administrative permissions are required to install the software under Microsoft Windows or
UNIX system.

Note: It is highly recommended to avoid using spaces and special characters in paths.

© 2004-2020 Openl Tablets
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3 Install OpenlL Tablets WebStudio under Apache
Tomcat

This section describes how to set up the environment for working with OpenL Tablets software and deploy
Openl Tablets WebStudio under Apache Tomcat and provides information about settings required for proper
functioning of the application.

Perform the following steps:

e Installing JDK
e Installing Apache Tomcat

e Deploying OpenL Tablets WebStudio

e Configuring External User Database

e Setting Up Openl Tablets WebStudio with Installation Wizard
e Integration with External Identify Providers

e Configuring Microsoft Excel Settings for Apache Tomcat

e Openl Tablets WebStudio Customization

3.1 Installing JDK

To install JDK, perform the following steps:

1. Download jdk-8u231 or later from http://www.oracle.com/technetwork/java/javase/downloads/index.html
to the target directory.

Further in the document, this catalog is referred to as <Java HOME>.

Note: It is highly recommended to avoid installing Java in the default Program Files directory because it can cause
problems due to space characters in the path to the folder.

For more information on the installation, see http://www.oracle.com/technetwork/java/javase/index-
137561.html.

2. Install JDK according to the instructions.

Now the environment variable Java_HOoME must be set to the pathname of the directory where JDK is
installed.

3. For MS Windows, set the environment variable Java HoME as follows:

1. To open the System Properties window, press <Windows> + <Pause> or right click the My Computer
icon and in the pop-up menu, select Properties.

In the Advanced tab, click Environment Variables.

In the System variables area, click New.

In the Variable name field, enter JAVA_ HOME.

In the Variable value field, enter the path to the directory where JDK is installed, for example,

C:\Java\jdkl.8.0 231.
6. Click OK to complete.

4. For Unix/Linux environments, assuming the target directory is /usr/1ib/jvm/jdk1.8.0 231, to set up the
environment variable gava HoME for a single user, proceed as follows:

a ~ w DN

1. Login tothe account and open .bash profile:nano ~/.bash profile.

© 2004-2020 Openl Tablets
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2. Add the following line:
export JAVA HOME=/usr/lib/jvm/jdk1.8.0 231.

3. Add or correct the system PATH as follows:
export PATH=$PATH:S$JAVA HOME/bin

4. To save, press CTRL+0 and then press CTRL+X to exit.

5. For Unix/Linux environments, assuming the target directory is /usr/1ib/jvm/jdk1.8.0 231, to set up the
environment variable gava HoME for all users, proceed as follows:

1. Loginasrootandopenthe nano /etc/profile profile.
2. Add the following line:

export JAVA HOME=/usr/lib/jvm/jdk1.8.0 231.
3. Add or correct the system PATH as follows:

export PATH=$PATH:$JAVA HOME/bin.

3.2 Installing Apache Tomcat

Apache Tomcat can be installed from a ZIP file or using Windows Service Installer. The following topics are
included in this section:

e Installing Apache Tomcat on Windows
e |nstalling Apache Tomcat on UNIX / Linux Machine

Installing Apache Tomcat on Windows
This section describes how to install Apache Tomcat on Windows and includes the following topics:

e |Installing Apache Tomcat from Zip File
e |nstalling Apache Tomcat Using Windows Service Installer

Installing Apache Tomcat from Zip File
To install Apache Tomcat 7.0.x or later, proceed as follows:

1. Open Apache Tomcat home page at http://tomcat.apache.org/index.html.

2. Inthe left-hand Download menu, click the latest available Tomcat version.

3. Locate the Binary Distributions area and in the Core list, click on the ZIP file corresponding to the required
Windows version.
4. Save the ZIP file in a temporary directory.
5. Extract the downloaded ZIP file into the target folder on the computer.
This folder is referred to as <ToMcaT HOME> further in this document.
6. Configure JVM options for Tomcat web server as follows:
1. Create TOMCAT HOME/start.cmd file and add the following line:
set JAVA OPTS=%JAVA OPTS% -Xms512m -Xmx2000m -XX:+UseParNewGC -XX:PermSize=128m -
XX:MaxPermSize=512m

2. Openthe TOMCAT HOME/conf/server.xml file and add the URIEncoding="uUTF-8" attribute for all
<Connector> elements.

For example:

© 2004-2020 Openl Tablets
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<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000"
redirectPort="8443" URIEncoding="UTF-8"/>

Installing Apache Tomcat Using Windows Service Installer

This section describes how to install Apache Tomcat using Windows Service Installer.

Note: It is not recommended to select this type of installation if planning to edit rule tables in Excel files from OpenL
Tablets WebStudio as described in [OpenL Tablets WebStudio User Guide], the Modifying Tables section. This type
of installation requires additional setup. To solve this issue, contact your OpenL Tablets administrator.

Note: For Openl Tablets administrator: to enable editing rule tables in Excel files from OpenL Tablets WebStudio, enable
the Allow service to interact with desktop Tomcat service option using MMC or from the command line.

Proceed as follows:

1. Navigate to the Apache Tomcat site at http://tomcat.apache.org/index.html and in the left-hand Download
menu, click the latest available Tomcat version.

2. Locate the Binary Distributions area and in the Core list, click the 32-bit/64-bit Windows Service Installer
link.

Save the apache-tomcat exe file in a temporary folder.

Run the exe file and follow the instructions of the installation wizard.
Click Next.
In the License Agreement window, click | Agree.

o g bk w

In the Choose Components dialog, leave the default Normal type of installation.
Experienced Tomcat users can select another installation type in the drop-down list.

~

In the Configuration dialog, proceed with default values.
8. In the next window, review the folder where Tomcat will be installed, the Destination Folder.
This folder is referred to as <ToMcaT HOME> further in this document.
9. Click Install to start the installation.
10. Click Finish to complete.
As a result, Apache Tomcat is installed and started on the user’s computer. In the Notification Area located

next to the clock, the icon appears. Tomcat is managed by using this icon or from the Start menu.

11. To configure JVM options for Tomcat, in the Notification area, right click the Apache Tomcat icon and select
Configure; or click Start > All Programs > Apache Tomcat 7.0 > Configure Tomcat.
The Apache Tomcat Properties dialog appears.

12. Click the Java tab and in the Java Options text box, add the following lines:

-Xms512m

-Xmx2000m

-XX: +UseConcMarkSweepGC
-XX:PermSize=128m
-XX:MaxPermSize=512m

Note that every option must be manually entered in a separate row.
13. Click Apply and then click OK.
14. To restart Tomcat, in Notification Area, right click the Tomcat icon and select Stop service.

The Tomcat icon changes to .
15. Select Start Service.

© 2004-2020 Openl Tablets
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Alternatively, Tomcat can be restarted from the General tab in the Apache Tomcat Properties window
which appears after selecting Start > All Programs > Apache Tomcat 7.0 > Configure Tomcat.

From this point, OpenlL Tablets WebStudio can be run as described in Deploying OpenL Tablets WebStudio.

Installing Apache Tomcat on UNIX / Linux Machine

This section describes how to install Apache Tomcat on the UNIX or Linux machine and includes the following
topics:

e Installing Apache Tomcat from Repository
e |Installing Apache Tomcat from ZIP File
e Configuring JVM Options for Tomcat on UNIX / Linux Machine

Installing Apache Tomcat from Repository

This section describes how to install Apache Tomcat from repository as a service on Ubuntu 12.x.
Note: All commands must be entered into a terminal window using an account with sudo privileges.
Proceed as follows:

1. Open aterminal window and enter the following:

sudo apt-get install tomcat?

2. Start Tomcat with the next command:
sudo /etc/init.d/tomcat7 start

All necessary folders must be located in /var/1ib/tomcat7.
3. To ensure that Tomcat works properly, open the browser and enter http://localhost:8080.
If all is correct, Apache Tomcat displays the welcome page with a message resembling the following:
If you're seeing this, you've successfully installed Tomcat. Congratulations!
If the 404 error appears, try to restart Tomcat as follows:

sudo /etc/init.d/tomcat7 restart
Alternatively, stop Tomcat by entering the following command in command line and then start it as
described previously:

sudo /etc/init.d/tomcat7 stop

Installing Apache Tomcat from ZIP File

This section describes how to install Apache Tomcat on Ubuntu 12.04 and Centos 6.3. The instructions are valid
for other Linux distributions with small changes.

Proceed as follows:

1. Download the appropriate Tomcat archive file, ZIP or tar.gz archive, from its official website
http://tomcat.apache.org/download-70.cgi to the required user folder.

In this example, Tomcat 7.0.39 is downloaded to the /home/myuser folder.

2. Open a terminal window and change directory to the folder containing the Tomcat archive.

3. Extract the archive by entering the following command in the terminal, modifying the Tomcat version as
required:
tar -zxvf apache-tomcat-7.0.39.tar.gz

The apache-tomcat-7.0.39 folder appears. For example:
/home/myuser/apache-tomcat-7.0.39

© 2004-2020 Openl Tablets
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Change directory to the tomcat /bin:

cd apache-tomcat-7.0.39/bin

Make sure all =.sh files are executable, that is, they have r in all positions to the left of the file name, for
example, -rwxr-xr-x.

For that, in terminal, enter the following:

ls —-la

The following information is displayed:

bahdanau bahdanau 40896

bahdanau bahdanau 4896

bahdanau bahdanau 28865

bahdanau bahdanau 13217 :45 catalina.bat
bahdanau bahdanau 19189 :45 catalina.sh
bahdanau bahdanau 2121 :46 catalina-tasks.xml
bahdanau bahdanau 24239

bahdanau bahdanau 208759

bahdanau bahdanau 2131 :45 configtest.bat
bahdanau bahdanau 1982 :45 configtest.sh
bahdanau bahdanau 1342 :45 cpappend.bat
bahdanau bahdanau 7492 :45 daemon.sh
bahdanau bahdanau 2178 :45 digest.bat
bahdanau bahdanau 20821 :45 digest.sh
bahdanau bahdanau 3264 :45 setclasspath.bat
bahdanau bahdanau 3524 :45 setclasspath.sh

P

( 9
1
1
|
1
1
1
1
|
1
1
1
¢ 1
1
1

Figure 1: OpenlL Tablets package is added

If some sh files are not executable, enter the following command:
chmod +x ./*.sh

Run the sturtup. sh file as follows:
sh ./startup.sh

In the browser, enter the following URL:
http://localhost:8080

If the installation is completed successfully, the Apache Tomcat welcome screen appears. The next thing to
be done is to configure JVM options for Tomcat.

Configuring JVM Options for Tomcat on UNIX / Linux Machine

To configure JVM options for Tomcat on a UNIX / Linux machine, proceed as follows:

1.

For UNIX, create TOMCAT HOME/start.cmd file and type the following:

export JAVA OPTS="SJAVA OPTS -Xms512m -Xmx2000m -XX:+ UseConcMarkSweepGC -XX:PermSize=128m
-XX:MaxPermSize=512m"

Locate the TOMCAT HOME/conf/server.xml file and add the URIEncoding="uTF-8" attribute for all
<Connector> elements.

For example:

<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000" redirectPort="8443"
URIEncoding="UTF-8"/>

From this point, deploy OpenlL Tablets WebStudio as described in Deploying OpenL Tablets WebStudio.

© 2004-2020 Openl Tablets
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3.3 Deploying OpenL Tablets WebStudio

This section describes how to deploy and run OpenL Tablets WebStudio under Tomcat.
The following topics are included:

e Deploying OpenL Tablets WebStudio on a Windows Machine
e Deploying OpenlL Tablets WebStudio on a Linux Machine and Max

Deploying OpenlL Tablets WebStudio on a Windows Machine

This section describes how to deploy and run OpenL Tablets WebStudio under Tomcat on a Windows machine.
Proceed as follows:

1. Go to the http://openl-tablets.org/downloads page.
2. Click the appropriate OpenL Tablets WebStudio WAR link.
3. Save the file in a temporary folder and then copy the OpenlL Tablets WebStudio WAR file.
For example, openl-tablets-webstudio-X.X.X.war to the <TOMCAT HOME>\webapps folder.

4. Run Tomcat as follows:
e If Tomcat is installed from the ZIP file, in ToMCAT HOME\bin, click the startup.bat file.
e |f Tomcat is installed using Windows Service Installer, restart Tomcat as described in Installing Apache
Tomcat Using Windows Service Installer.

Tomcat unpacks the WAR file into the <ToMCAT HOME>\webapps\<war file name> folder. For example, for
5.9.4 version the target folder can be <TOMCAT HOME>\webapps\openl-tablets-webstudio-5.9.4. For
convenience, the folder can be renamed as needed but remember that this name is used to launch OpenL
Tablets WebStudio under Tomcat.

From this point on, run Openl Tablets WebStudio with default settings or make additional customizations by
changing the user mode and configuring an external user database as described in [OpenL Tablets Rule
Service Usage and Customization Guide].

5. To run Openl Tablets WebStudio, in the browser, enter the following URL:
http://localhost:8080/<WAR file name>
That is, for this example, the URL is http://localhost:8080/openl-tablets-webstudio-5.9.4.
Openl Tablets WebStudio is opened in the browser on the Welcome to Installation Wizard page. The wizard
will guide through the setup process as described in Setting Up OpenL Tablets WebStudio with Installation
Wizard. When setup is complete, use OpenL Tablets WebStudio to create new projects or download existing
ones.

6. After a new release of the OpenL Tablets WebStudio is installed, click CTRL+F5 or clear cookies and cash
manually to reload the page in the browser.

Deploying OpenL Tablets WebStudio on a Linux Machine and Mac
To install OpenL Tablets WebStudio under Linux and Mac OS, perform the following steps:

1. Create the <orPENL_ HOME> folder where the application will be deployed as follows:
sudo mkdir /<OPENL HOME>

2. Change access rights for this folder by entering the following command in the command line:
sudo chmod 775 -R /<OPENL_ HOME>

© 2004-2020 Openl Tablets
OpenlL Tablets 5.22 Page 13 of 55


http://openl-tablets.org/downloads
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Web%20Services%20Usage%20and%20Customization%20Guide.pdf
http://openl-tablets.org/files/openl-tablets/latest/OpenL%20Tablets%20-%20Web%20Services%20Usage%20and%20Customization%20Guide.pdf

OpenlL Tablets Installation Guide Install OpenL Tablets WebStudio under Apache Tomcat

3. Change the owner for this folder:
sudo chown tomcat7:tomcat7 /<OPENL HOME>

4. Download OpenlL Tablets WebStudio WAR file from https://github.com/openl-tablets/openl-
tablets/releases/ to a temporary folder.

5. Copy the downloaded WAR file to the Tomcat webapps folder:

cp /home/myuser/Downloads/<openl-tablets-webstudio-
xxxx.war>/home/myuser/<TOMCAT HOME>/webapps/webstudio.war

6. To stop Tomcat, run the following command from /home/myuser/<TOMCAT HOME>/bin :
sh shutdown.sh
7. Start Tomcat from the same folder as follows:
sh startup.sh
8. Inthe browser, enter http.//localhost:8080/webstudio.
If deployment is completed without errors, the OpenL Tablets WebStudio Installation Wizard described in
the next step is opened in the browser.
If encountering any problems, for more information, see the following log files:

home/myuser/<TOMCAT HOME>/logs/catalina.out and
home/myuser//<TOMCAT HOME>/logs/webstudio.log

3.4 Configuring External User Database

This step is only required if a user is planning to work in multiuser application modes such as Multi-user, Active
Directory, SSO: CAS or SSO: SAML. For more information, see Setting Up OpenL Tablets WebStudio with
Installation Wizard and use an external database such as MySQL for managing users in OpenL Tablets
WebStudio.

By default, OpenL Tablets WebStudio can run using an internal user database based on the HSQLDB database
engine. It is a good idea to use the internal user database for demonstration purposes because it is provided by
default and requires no additional setup. But in this case, all user management changes will be lost after server
restart.

In a production environment, it is strongly recommended to use an external database.

Note: For more information on supported platforms, see http://openl-tablets.org/.

The following topics are included:

e Adding Drivers and Installing and Configuring the Database
e Configuring MySQL Database as External User Storage

e Configuring MariaDB Database as External User Storage

e Configuring Oracle Database as External User Storage

Adding Drivers and Installing and Configuring the Database

Before configuration, perform the following steps:

1. Add the appropriate driver library for a database in OpenL Tablets WebStudio to \WEB-INF\1ib\.
Alternatively, locate required libraries directly in \<ToMCAT HOME>\1ib with other Tomcat libraries.
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Driver name for appropriate databases

Database Driver

MySQL mysgl-connector-java-5.1.31.jar
MariaDB mariadb-java-client-2.0.1.jar
Oracle ojdbcé.jar

MS SQL hsgldb-2.3.2.jar

PostgreSQL postgresgl-9.3-1100.jdbc4.jar

For more information on URL value according to the database type, see the URL value according to the
database type table in Setting Up OpenL Tablets WebStudio with Installation Wizard.

2. Install the database, defining login and password and creating a new schema or service.

Ensure all database settings are completed.
3. Start OpenL Tablets WebStudio and in the third step, select a Multi-user, Active Directory or SSO mode.
4. Define database URL, username, and password.

Configure database:;

Set up a database to be used for managing users in OpenlL Tablets webStodia,
Please contact vour Systern Adrinistrator for this information if necessary,

Catabase URL | jdbc-oraclethin@localhost: 1521:arcl

Login: apenl
Password: wnenn
Prev

Figure 2: Creating a connection to the Oracle database in the installation wizard

5. Click Finish to close the wizard when the installation is complete.

6. Login as user admin with password admin.
Note that even after configuring the database as user storage, a default user is available for login. The user
admin with administrative rights can manage user settings in OpenL Tablets WebStudio, for example, create
a user or add privileges to a user. All user management activities can be performed via the OpenlL Tablets
WebStudio Ul, in the Admin > User Management section.
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Username TestUser
Password’  sesseenn
Fist Name
Last Name
Testers
Deployers
£y Deveiopers
Groups
¥ Analysts
Acmurstratons

BWers

Figure 3: Managing users in the User Management section of OpenL Tablets WebStudio

Right after applying changes in OpenL Tablets WebStudio, the updates are applied to the database. A user can
log in and work under a newly created account in Openl Tablets WebStudio.

Note: During installation, several tables are created in the database. If the same tables exist in the database from the
previous usage, a conflict occurs. To avoid this situation, the following tables must be removed:

e ACCESSCONTROLENTRY

e GROUP2GROUP

e OPENLUSER

e schema_version

e USER2GROUP

e USERGROUP

e HIBERNATE_SEQUENCE table that has SEQUENCE_OWNER=0OPENL

The previous steps describe configuration when a user starts OpenlL Tablets WebStudio for the first time.
Otherwise, in the openl\user-workspace folder, the following changes must be made:

1. Inthe system-settings folder, locate the db.properties configuration file and edit it described in the
following example for the Oracle database:

D db properties

db.ur1l = jdbc:oracle:thin:@localhost:1521:openltest

db.user = open]

db.password = open

db.driver = oracle. jdbc.driver.oraclebDriver
db.hibernate.dialect = org.hibernate.fdialect.oraclelOgDialect
db.validationquery = SELECT 1 FROM dual

db.url.separator = @

Figure 4: Configuration file with Oracle database settings
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2. Inthe system.properties file, set variable user.mode = multi.

Configuring MySQL Database as External User Storage
This section explains how to set up a MySQL database. Proceed as follows:

1. Go to http://dev.mysal.com/downloads/mysql/.

2. Select the appropriate MSI Installer for system configuration and click Download.

For example, Windows (x86, 32-bit), MSI Installer may be needed. It is recommended to use ZIP Archive
version since it is intended for advanced users.

3. Inthe next window, register or log in to the MySQL site.
This step can be skipped, and users can proceed to No thanks, just start my download! link.

4. Inthe next window, select Save File and save the .msi file in a target folder.

5. Navigate to the folder containing the .msi file and double click the file to start the installation process.
The MYSQL Server Setup Wizard Welcome window appears.

6. Follow the wizard steps leaving the default values and clicking Next to proceed.

7. Click Finish to close the wizard when installation is complete.

Note: It is recommended to configure the database server to use the UTF-8 character set.

When MySQL is successfully installed on the user’s computer, an empty database for OpenL Tablets
WebStudio in MySQL must be created and permissions to modify this database granted to the user from
which the OpenL Tablets WebStudio will work with this database.

8. To open MySQL Command Line Client, select Start > All Programs > MySQL > MySQL Server 5.5 > MySQL
Command Line Client and enter the following commands:
CREATE USER openl user IDENTIFIED BY 'openl password';
CREATE DATABASE openl CHARACTER SET utf8;
GRANT ALL PRIVILEGES ON openl.* TO openl user;

Configuring MariaDB Database as External User Storage

This section explains how to set up an MariaDB database. Proceed as follows:

1. Go to https://downloads.mariadb.org.

2. Select the appropriate version and click Download.

3. Select the appropriate MSI Installer for system configuration and click Download.

4. In the next window, select Save File and save the .msi file in a target folder.

5. Navigate to the folder containing the .msi file and double click the file to start the installation process.
The MariaDB Setup Wizard Welcome window appears.

6. Follow the wizard steps leaving the default values and clicking Next to proceed.

7. Define password for a root user.

8. Create a database.
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j!_{‘;! Database settings = ——
Default instance properties ://_j
MariaDB 10.2 (x64) database configuration . ;
MariaDB

Install as service

Service Mamne:! Maria

Enable networking

TCP port: ISSD?

Innodb engine settings

Buffer pool size: 2045 MG

Page size: KE

[ Back ” Mexk ] [ Cancel

Figure 5: Setting properties for the MariaDB database

9. Click Finish to close the wizard when the installation is complete.

10. Start HeidiSQL application.

11. Click New to create a session.

12. Select the Prompt for credentials check box and define a database port.

@ Sessicn manager B |-

Session narne « &7 Settings | % Advanced ||ﬂ;| Statisticsl
| t‘,{ Unnarned *

Netwark type: (MySQL (TCP/P) -|

Hostname J I 127001

DPromptforcredentiaIs

Use Windows authentication

User: root
Password: ..
Por: 3307 =

[T Compressed client/server protacol
Databases: Separated by sernicaolon v

Comment:

’New |V]’ Sawe ][ Delete ] Open H Cancel H kdore |Vl

Figure 6: Creating a connection to the MariaDB database

13. Click Open and save the changes.
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Configuring Oracle Database as External User Storage
This section explains how to set up an Oracle database. Proceed as follows:

1. Go to http://www.oracle.com/technetwork/database/enterprise-edition/downloads/index.html.

2. After registration, select the appropriate version and system configuration, and click Download.
3. Unzip 2 archives in one folder and click the exe file.
4. Configure the database and define a username and password.

These values will be used further for configuration.

5. To improve work with database, download Oracle SQL Developer at
http://www.oracle.com/technetwork/developer-tools/sqgl-developer/overview/index.html.

In this section, as an example, Oracle SQL Developer 3.2.2 is used.
6. Start Oracle Workbench and create a connection or select an existing database connection.

' Ny
Q New / Select Database Connection &

Copnection Name My _connection2|
Username openl
Password eeee

Saye Password

Orade  Access

Connection Type |Basic ¥! Role |default ¥

Hostname locahost
Pot 1521
%) SIp openitest
Service name

OS Authenticaton Kerberos Authentication Proxy Connection

Help Save ‘ Clear Test Connect | Cancel

Figure 7: Creating a connection to the Oracle database

7. Enter username and password values defined when installing the database.

3.5 Setting Up Openl Tablets WebStudio with Installation
Wizard

This topic describes the steps that must be taken after the first run of OpenL Tablets WebStudio under Tomcat
or WebSphere Application Server. For more information, see Install OpenL Tablets WebStudio and OpenL
Tablets Web Services on WebSphere Application Server. Accept the default options provided by the wizard by
clicking Next to move to the next step or change the options as required and click Next to proceed.

Proceed as follows:

1. Inthe Welcome to OpenL Tablets WebStudio Installation Wizard window, click Start.
2. Inthe next window, specify a working directory for OpenlL Tablets.
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By default, the following directory is displayed:

c:\Users\username\.openl\
This folder is referred to as <oPENL_HOME> in the documentation. It is highly recommended not to use the
system drive for that.

3. Click Next to proceed.

4. Specify deployment and design repositories:

Connection types for setting up design and deployment repositories

Type Description

Local The repository is located on the local machine as a folder. This folder must be specified in the
Repository Directory field.

Remote - RMI The repository is located on a remote server and can be accessed by the RMI protocol. The
Repository URL field displays URL for remote access to the repository.

Remote - The repository is located on a remote server and can be accessed via WebDav protocol. The

WebDav Repository URL field displays URL for remote access to the repository.

Database The repository is located in a database installed either local or remote. The Repository URL field

(JDBC) displays URL for access to the database.

Database The repository is located in a database installed either locally or remotely. The Repository URL

(JNDI) field displays URL for accessing the database. Configuration settings are located in configuration
files of the web server application.

AWS S3 The repository is located in Amazon Simple Storage Service (AWS S3). A “bucket” is a logical unit of

storage in AWS S3, and is globally unique. Choose a region for storage to reduce latency, costs etc.
An Access key and a Secret key are needed to access storage. If empty, the system will retrieve it
from one of the known locations as described in AWS Documentation. Best Practices for Managing
AWS Access Keys. The Listener period is the interval in which to check repository changes, in
seconds.
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If deploy configuration must be stored in a separate repository, not in Design repository, the Use Design
Repository check box must be cleared and required parameter values must be provided.

The following table explains URL values according to the database type:

URL value according to the database type

Database URL value

MysSQL, jdbc:mysqgl://[host] [:port]/ [schema]

MariaDB

Oracle jdbc:oracle:thin:@//[ host] [:port]/service

MS sQL jdbc:sglserver://[serverName[\instanceName] [:port]] [;property=value[;propert

y=value]]

PostgreSQL jdbc:postgresqgl://[host] [:port]/[schema]

For more details about how to configure the repository of a specific type, please refer to the corresponding
subchapter below:
e Configuring OpenL Tablets WebStudio via JDBC Connection
e Configuring OpenL Tablets WebStudio via JNDI Connection
e Configuring OpenL Tablets WebStudio via Amazon Simple Storage Service
For more information on repository security, see [OpenL Tablets WebStudio User Guide], the
Repository Settings section.
5. Click Next.
6. Select a user mode as described in the following table:

User modes

Mode Description

Demo This is a multi-user mode with the list of users predefined in the default database. The database
does not require additional setup. All changes in the database will be lost after the application
restart.

Single-user Only the user currently logged on to the computer can work with the OpenL Tablets WebStudio.
For more information on the single user mode, see [OpenlL Tablets WebStudio User Guide].

Multi-user Multiple users can run OpenL Tablets WebStudio with their unique names. WebStudio is used to

(recommended) authenticate and manage user credentials/permissions with External database.

Active Directory  Multiple users can run OpenlL Tablets WebStudio using their unique user names. Active Directory
will be used to authenticate and manage user credentials.

SSO: CAS Multiple users can run OpenL Tablets WebStudio using their unique user names. CAS (Central
Authentication Service) server will be used to authenticate and manage user credentials.

SSO: SAML Multiple users can run OpenL Tablets WebStudio using their unique user names. SAML (Security
Assertion Markup Language) supporting Identity Provider server will be used to authenticate and
manage user credentials.

For Active Directory, SSO: CAS, SSO: SAML, user modes proceed as described in Integration with External
Identity Providers.

7. If Multi-user, Active Directory, SSO: CAS or SSO: SAML mode is selected, in the Configure database area
that appears, modify the database parameters as follows:
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Database parameters

Parameter Description

Database URL Enter the URL for the selected database.

Login / Password Username and password specified for the database as defined in Configuring External User
Database.

8. Click Finish to complete setup.

As a result, for the Demo, Multi-user, Active Directory, SSO: CAS and SSO: SAML modes, the login screen
appears for entering user’s credentials to start working with OpenlL Tablets WebStudio. By default, there are the
following users in OpenL Tablets WebStudio predefined:

Openl Tablets WebStudio users

User name User password Groups

admin admin Administrators

For a list of users predefined in the Demo application mode, see [OpenL Tablets WebStudio User Guide], User
Management > Manage Users.

Configuring OpenL Tablets WebStudio via JDBC Connection

Configure design and deployment repositories settings on the second step of OpenL Tablet WebStudio
installation wizard as follows:

1. Select JDBC as the type of the connection database (JDBC).

2. Provide URL and authentication data.

If the Deployment repository is created in an Openl Tablets version older than 5.20, the Version in
deployment name check box must be selected to enable backward compatibility.
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Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Name: * Deployment

Type: * Database (JDBC) B
URL: * jdbc:oracle:thin: @localhost:1521:orcl
Secure connection: vl

Login: OPENL

Password: escoe

Version in deployment name: [

Create Deployment Repository = Connect To Deployment Repository

Prev

s Rrbe e

Figure 8: Setting up a JDBS connection using the installation wizard

Configuring OpenlL Tablets WebStudio via JNDI Connection

To configure the Openl Tablets WebStudio via JNDI connection, perform the following steps:

e Configuring Resources for JNDI Context
e Configuring Settings in Openl Tablets WebStudio

Configuring Resources for JNDI Context
Resource settings must be configured before deploying the application. Proceed as follows:

1. Openthe \conf\context.xml file in Apache Tomcat and add the Resource tag as described in the following
examples.

For the Oracle database, an example is as follows:

<Resource name="jdbc/oracleJNDI” auth="Container”
type="javax.sqgl.DataSource” username="user” password="password”
driverClassName="oracle.jdbc.OracleDriver”
url="jdbc:oracle:thin:@localhost:1521:0rcl”
maxActive="8"

/>
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2.

For the MySQL database, an example is as follows:

<Resource name="jdbc/mysqlINDI” auth="”Container” type="javax.sql.DataSource”
maxActive="100" maxIdle="30"” maxWait="”10000"
username="javauser” password="javadude”
driverClassName="com.mysqgl.jdbc.Driver”
url="jdbc:mysqgl://localhost:3306/javatest”
/>

For the MS SQL database, an example is as follows:
<Resource name="jdbc/mssqlJNDI” auth="Container”

type="javax.sql.DataSource” username="wally” password="wally”
driverClassName="com.microsoft.sqglserver.jdbc.SQLServerDriver”
url="jdbc:sqglserver://localhost;DatabaseName=mytest;SelectMethod=cursor;”
maxActive="8"
/>

For the PostrgeSQL database, an example is as follows:

<Resource name="jdbc/postgres” auth="Container”
type="javax.sql.DataSource” username="postgres” password="Passwordl”
driverClassName="org.postgresql.Driver”
url="jdbc:postgresqgl://localhost:5432/postgres”
maxActive="8"

/>
Save the context.xml file.

Configuring Settings in OpenlL Tablets WebStudio

Configure design and deployment repositories settings on the second step of OpenlL Tablets WebStudio
installation wizard as follows:

1.
2.

Select JNDI as the type of the connection database.

Enter a URLin the java:comp/env/<resource name> format.

Definition of the authentication data, that is, login and password, is not required in the installation wizard
because this information is set in context.xml file already.

If the Deployment repository was created in an OpenlL version older than 5.20, the checkbox “Version in
deployment name” must be checked to enable backward compatibility
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Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Name: * Deployment
Type: * Database (JNDI) B
URL: * java:comp/env/jdbc/deploymentDB

Secure connection: (]

Version in deployment name: ||

Create Deployment Repository  Connect To Deployment Repository

Figure 9: Setting up JNDI connection with installation wizard

Configuring OpenlL Tablets WebStudio via Amazon Simple Storage Service

Configure design and deployment repositories settings on the second step of OpenL Tablets WebStudio
installation wizard as follows:

1. Select AWS S3 as the type of connection.
2. Specify the following information:

AWS S3 parameters

Parameter Description

Bucket name Enter the name of the bucket in which your data resides.

Region name Select the name of the AWS region in which your bucket resides.

Access key Enter your Amazon AWS access key.

Secret key Enter your Amazon AWS secret access key.

Listener period The time, in seconds, to wait for the Amazon server to respond.

(sec)

Version in Select the Version in deployment name check box for backward compatibility if the

deployment name  geployment repository is created in an OpenL Tablets version older than 5.20.

3.6 Integration with External Identity Providers

To enhance sign in options for users, a third-party authentication can be established between organization
authentication systems and OpenL Tablets WebStudio. After enabling third-party authentication, users can sign
into OpenL Tablets using their organizational credentials.

The following topics are included in this section:
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e Internal vs. External User Management

e Configuring Authentication via Active Directory
e Configuring Single Sign On via CAS

e Configuring Single Sign On via SAML Server

Internal vs. External User Management

Openl Tablets WebStudio allows selecting where user permissions are managed in the case of integration with
external identity providers. The following options are available:
e internal user management

An administrator can create any groups and manage authenticated user permissions in OpenL Tablets
WebStudio. If this option is selected, the Configure initial users section appears in the third step of the
installation wizard. Define the following information:

1. Provide at least one user to be granted administration privileges in the Administrators field.
2. Select the All authenticated users have View access check box to grant viewer privileges by default.

Configure initial users:
Add comma separated users with administrator privileges and make a decision if a new users will have View Access

to WebStudio

Administrators: * openladmin

5y

&ll authenticated users have View access (¢

Figure 10: Internal user management: Configuring initial users.

e external user management

User groups are managed in Active Directory or SSO. Configure OpenlL Tablets groups equal to Active
Directory or SSO groups in step 4 of the installation wizard. To configure OpenL Tablets groups, proceed as
described in [OpenlL Tablets WebStudio User Guide], Managing Groups section.
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Configure groups and their privileges:

Edit groups that will have access to Openl WebStudio and configure privileges for them. You can see an example of
such groups below. Rename the groups to match available Active Directory or 550 groups, create new ones or
delete unneeded ones.

Name Description Privileges

Administrators
Analysts
onfiguraion | Erase Deploy Configuration

Deployers
Pl
. crots Prjects | Creste Tables
Evelopers
: Remowve Tables | Edit Projects | Edit Tables | Delete Projects
Viewers View Projects

A EE A EE A EE AR

Add New Group

Prev gL Click 'Finish' to complete the installation process

Figure 11: Editing User Groups on WebStudio to match Active Directory or SSO groups.

Configuring Authentication via Active Directory
This section explains how to set up authentication via Active Directory. Proceed as follows:
1. Select Internal user management or External user management.

The steps required for this configuration are described in Internal vs. External User Management.

2. Specify Active Directory domain and URL.

3. To verify connection to Active Directory, enter credentials of the existing Active Directory user and click
Check Connection.
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Login:

Password:

configure Active Directory:

Set up an Active Directory to use for managing users in Openl Tablets WebStudio

Please contact your System Administrator for this information if necessary

Active Directory domain: * | kKapserver.com

Active Directory URL: ™ idap idapserver 3268

Lagin and Password are used to check connection to Active Directory. They will not be saved anywhere.

openlidmin

srsmERERY

Check connection

Figure 12: Configuring authentication via Active Directory

Configuring Single Sign On via CAS

This section explains how to set up authentication via CAS. Proceed as follows:

1. Select Internal user management or External user management.

The steps required for this configuration are described in Internal vs. External User Management.

2. Define the following parameters:

CAS configuration parameters

Parameter

Description

WebStudio server
URL

URL for OpenlL Tablets WebStudio.

CAS server URL

URL for the selected CAS server.

Attribute for First CAS attribute for the first name. Keep it blank if the CAS server does not return this
Name attribute.

Attribute for Second CAS attribute for the second name. Keep it blank if the CAS server does not return this
Name attribute.

Attribute for Groups

CAS attribute for groups. Keep it blank if the CAS server does not return this attribute.
Applicable for Internal user management only.

Note: Contact CAS server administrator for attribute names information.
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Configure CAS:
Set up a CAS to use for managing users in Openl Tablets WebStudio.

Please contact your System Administrator for this information if necessary.

WebStudio server URL: * https:iocalhost: 5443/ webstudic

CAS server url; * hitps./icasserver 844 3/cas
Attribute for First Name: givenMame
Attribute for Second Name: zecondiame

Attribute for Groups: © userEnoup

Figure 13: Configuring CAS

Configuring Single Sign On via SAML Server

This section explains how to set up authentication via the SAML server. Proceed as follows:

1.

Select Internal user management or External user management.

The steps required for this configuration are described in Internal vs. External User Management.

Define the followi

ng parameters:

SAML configuration parameters

Parameter

Description

WebStudio server
URL

URL for OpenL Tablets WebStudio.

SAML server
metadata URL

URL of the metadata XML file of the Identity Provider.

Request timeout

Time, in milliseconds, to wait for the metadata server to respond.

Keystore path

File pointing to the JKS keystore.

Keystore password

Password of the JKS keystore file.

Keystore SP alias

Service Provider alias for key in the keystore.

Keystore SP
password

Password to access the Service Provider key.

Authentication
Contexts

Comma separated list of authentication contexts that IDP is allowed to use when
authenticating a user. This value can be left blank.

Local logout

Identifier that can be set to true for local logout, logging out only from OpenL Tablets
WebStudio, or false for global logout, logging out from all services using this IDP.

Attribute for
Username

SAML attribute for a username. Keep it blank if SAML server does not return this attribute, or if

default algorithm for username retrieval must be used.

Attribute for First
Name

SAML attribute for the first name. Keep it blank if SAML server does not return this attribute.

Attribute for
Second Name

SAML attribute for second name. Keep it blank if SAML server does not return this attribute.
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SAML configuration parameters

Parameter Description
Attribute for SAML attribute for groups. Keep it blank if SAML server does not return this attribute.
Groups Applicable for Internal user management only.

Configure SAML:

Set up SAML to use for managing users in OpenL Tablets WebStudio.
Please contact vour System Administrator for this information if necessary.

WebStudio server URL: * hitp-fMocalhost: 2080 Awebstudio

SAML server metadata url: * | hitp:flocalhost:3080/idp-meta_sxml

Fequest timeout: ™ 15000

Keystore path: ™ classpath security/keystore jks

Keystore password: & rernsna

Keystore SP alias: * webstudic

Keystore SP password: © sassEEE

Authentication Contexts: urm:casiz:namses:tc.SAML: 2.0:8c classesPas

Local logout

Attribute for Username: userklame
Attribute for First Name: firstMame
attribute for Second Name: | lastname

Attribute for Groups: * USErNZnoup

Figure 14: Configuring SAML

3.7 Configuring Microsoft Excel Settings for Apache Tomcat

The Open in Excel functionality does not work under the default settings if Apache Tomcat is installed on
Windows using Windows Service Installer as described in Installing Apache Tomcat Using Windows Service
Installer. This case requires a user to make several configuration changes.

To change DCOMConfig settings for Excel, proceed as follows:

1. Runthe dcomconfig.exe utility using administrator credentials:

Start > dcomcnfg.exe

The Component Services window appears.
2. In Console Root, select Component Services > Computers > My Computer > DCOM Config.
3. Navigate to the Microsoft Excel Application at the right.

If Microsoft Excel Application is not available under DCOMConfig settings, on the 64 bit system with 32 bit
Office, select Start > Run mmc -32 > File > Add/Remove Snap-in... > Component Services > Add > OK >
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Console Root > Component Services > Computers > My Computer > DCOM Config > Microsoft Excel
Application.

Right click Microsoft Excel Application and in the drop-down menu, select Properties.
In the Microsoft Excel Application window, click the Identity tab.
Select This user.

N o g &

Click OK to complete.

®. Component Services

@ File  Action View Window 0 pgicrocoft Excel Application Properties @
o= 2E XD H]
Mex2Setup Class N
MaodMdeOutputProfile Which user account do you want to use to run this application?

MeetingloinAxOC
MFCongestionController

| General I Location I Security I Endpoints | Identity |

Bppli

hs
@) The interactive user.

MhegVM

Microsoft Audic Device C (7)) The launching user.

Microsoft Block Level Bac .

Microsoft Excel Applicatic () This user.

Microsoft IMAPI C Bonee

Microsoft Outlook
Microsoft PowerPoint Ap
Microsoft TEC Server
Microsoft Volume Shado
Microsoft WBEM Active S
Microsoft WBEM Unsecw
Microsoft Windows Defer
Microsoft Windows Font
Microsoft Windows Remu

The system account (services only).

Microsoft Windows Rermi
Microsoft Windows WS5MM
Microsoft Windows WS5MM
Microsoft WMI Provider £
Microsoft WMI Provider £
Microsoft Word 97 - 2003
MMC Application Class

MSDAINITIALIZE - ok ][ Cancel | [ Apply |
4 1 2

Leam more about setting these properties.

e 0 L O e O e 0 O O O O O I I

Figure 15: Microsoft Excel Application Properties

3.8 Openl Tablets WebStudio Customization

This section describes additional configuration for OpenL Tablets WebStudio and includes the following topics:

e Updating User Database Configuration

e Configuring User Mode

e Configuring Google Analytics

e Configuring Private Key for Repository Security

Updating User Database Configuration

User database settings, such as connection, login, and password data, are modified using the
<OPENL_HOME>/system-settings/db.properties file.

An example of the configuration that can be used for the user database is as follows:

db.hibernate.dialect = org.hibernate.dialect.MySQLDialect
db.driver = com.mysqgl.jdbc.Driver
db.url = jdbc:mysqgl://localhost:3306/openl
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db.user = openl user
db.password = openl password

Configuring User Mode

Normally, user mode in OpenL Tablets WebStudio is set to multi-user by using OpenL Tablets WebStudio
Installation Wizard as described in Setting Up OpenL Tablets WebStudio with Installation Wizard.

User mode can also be changed as a JVM option for Tomcat. For that, open the Apache Tomcat Properties
dialog as described in Installing Apache Tomcat Using Windows Service Installer, and in the Java Options text
box, add the following line:

-Duser.mode=multi

Note: User mode set as a Java option takes precedence over the corresponding value specified in the OpenL Tablets
WebStudio Installation Wizard. If both are defined, the Java option value is used.

Configuring Google Analytics

Google Analytics is a service offered by Google that generates detailed statistics about website traffic and traffic
sources. To configure Google Analytics for OpenL, open the Apache Tomcat Properties dialog as described in
Installing Apache Tomcat Using Windows Service Installer and in the Java Options text box, add the following
lines:

-Dwebstudio.analytics=number

Alternatively, configure Google Analytics for OpenL in the config.properties file located in \WEB-INF\conf\
as follows:

webstudio.analytics=number

number is @ number provided by Google during registration.

Configuring Private Key for Repository Security

OpenlL Tablets WebStudio allows connecting to secured repositories. In this case, passwords are stored in OpenL
Tablets WebStudio workspace. To improve passwords protection, a private key can be used.

Private key is a special secure sentence for coding and encoding repository passwords. By default, the private
key is empty. It can be set up as a JVM option for Tomcat by adding and specifying the value of the following
parameter:

repository.encode.decode. key.
The private key must be specified without spaces.

Note: The private key must be configured prior to creating any secured connections. Otherwise, all stored passwords
become invalid.

To enable private key usage for password encoding, modify the repository.encode.decode. key property in
the {TOMCAT HOME}\webapps{APP NAME}\WEB-INF\conf\system.properties file. By default, for OpenL
Tablets Web Services, this property is empty, and for OpenL Tablets WebStudio, it contains the This is the key
for password secure phrase.
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4 Deploy Openl Tablets Web Services under
Apache Tomcat

This chapter is designed for rule developers who need to use business rules as separate web services.

For more information on how to configure Openl Tablets Web Services, see [OpenL Tablets Rule Service Usage
and Customization Guide].

Before deploying OpenL Tablets Web Services under Apache Tomcat, ensure the following tasks are performed:

e The Java HOME environment variable is set to the pathname of the directory where JDK is installed.
e JVM options are set up as described in Installing Apache Tomcat.

The folder where Tomcat is installed is referred to as <TOMCAT HOME>.
This section contains the following topics:

e Downloading Preconfigured OpenL Tablets Web Services

e Configuring OpenL Tablets Web Services for a Local File System Data Source
e Configuring File System Data Source to Support Versioning of Deployments
e Configuring OpenL Tablets Web Services for a Database Data Source

4.1 Downloading Preconfigured Openl Tablets Web
Services

To download the preconfigured Openl Tablets Web Services application in a WAR file, proceed as follows:

1. Locate http://openl-tablets.org/downloads.
2. Click the appropriate OpenL Tablets Web Services WAR link.
3. Save the WAR file to the <ToMCAT HOME>\webapps directory.

4.2 Configuring Openl Tablets Web Services for a Local File
System Data Source

Using a file system as a data source for user projects means that projects are stored in a local folder. This folder
represents single deployment containing all projects. Each project must also be represented as a separate folder.
This is the default data source configured in the system.

To deploy OpenL Tablets Web Services, configure a local file system as a data source as follows:

1. Navigate to the <TOMCAT HOME>\webapps folder and extract the OpenL Tablets Web Services WAR file.
For example, right click the OpenL Tablets Web Services WAR file name and select 7-zip > Open archive.

For more information on downloading OpenL Tablets Web Services as a WAR file, see Downloading
Preconfigured OpenL Tablets Web Services.

2. Navigate to the wEB-INF\classes folder, open the application.properties file, and for the
ruleservice.datasource.dir setting, define the address to the folder with projects.
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For example:
ruleservice.datasource.dir = d:/datasource/

Note that for proper parsing of Java properties file, the path to the folder must be defined with a slash (‘/’)
as the folders delimiter. Back slash “\” is not allowed.

3. Checkif the property is defined as production-repository.factory =
org.openl.rules.repository.LocalRepositoryFactory.

4. Save the rule project in the appropriate datasource folder.

Every rule project must be represented as a separate folder. As an example, use OpenL Tablets Tutorial
available at http://openl-tablets.org/documentation/tutorials.

5. Torun Tomcat, in <TOMCAT HOME>\bin, click the startup.bat file.

To ensure the deployment is successful, try loading the appropriate CXF page with web services.
An example is http://localhost:8080/openl-tablets-ws-X.X.X.

Note: The Tomcat log file contains a URL that must be used to run the OpenL Tablets Web Services. For a file system data
source, the URL must resemble http://localhost:8080/<ws war file name>/<datasource
folder>/<rule project name>?wsdl, where <datasource folder>/<rule project name> can be taken
from the Tomcat log file.

Users can also pack their rule projects in a jar file and use this file as a data source as described in [OpenlL
Tablets Rule Service Usage and Customization Guide], JAR File Data Source section.

4.3 Configuring File System Data Source to Support
Versioning of Deployments

To deploy several projects which use the same Java classes, in application.properties, setthe
ruleservice.datasource.filesystem.supportDeployments property to true.

To enable saving different versions of the same project, in application.properties, set the

ruleservice.datasource.filesystem.supportVersion propertyto true.

Storing project versions becomes available only when

ruleservice.datasource.filesystem.supportDeployments=true.

Each project must be located in a separate folder with name ending resembling _v2, or _v0.0.2 for old format of
deployments.
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L[]

) [deployment2_v0.0.3]

__|deployment2_v0.0.2]

)[deployment3_v1]

_)[dep1_v2]

[dep1_v4] wd:\Working workspace \datasource\deployment2_v0.0.3\Project2-CorporateRating\*. =
Wms
* L]
[rules]
org]
) [META-INF]
)[com]

ratingservice

|2 rules

Figure 16: File system data source with versions

4.4 Configuring Openl Tablets Web Services for a Database
Data Source

This section describes how to configure settings to connect to a database for storing deployed projects there.
Such configuration requires that the appropriate database exists and is launched. The following topics are
included:

e Configuring Openl Tablets Web Services via JDBC Connection
e Configuring Openl Tablets Web Services via JNDI Connection
e Configuring Openl Tablets Web Services via AWS S3 Connection

Before configuration, add the appropriate driver library for a database in OpenL Tablets Web Services to \WEB-
INF\1ib\ .Alternatively, locate required libraries directly in \<ToMCAT HOME>\1ib with other Tomcat libraries.
Install the database, defining a login and password and creating a new schema or service.

For more information on drivers, see the Driver name for appropriate databases table in Adding Drivers and
Installing and Configuring the Database.

Configuring OpenlL Tablets Web Services via JDBC Connection
To set up JDBC connection settings for OpenlL Tablets Web Services, proceed as follows:

1. Openthe WEB-INF\classes\application.properties file.
2. Set the following properties with the following values:

production-repository.factory = org.openl.rules.repository.db.JdbcDBRepositoryFactory
production-repository.uri = jdbc:mysgl://localhost/deployment-repository

3. Setthe URL value for production-repository.uri according to the appropriate database as described in
the URL value according to the database type table in Setting Up OpenL Tablets WebStudio with Installation
Wizard.

4. Setthelogin production-repository.login and password production-repository.password for
connection to the database defined while installing the database.

The password must be encoded via the Base64 encoding schema when repository.encode.decode.key is
also defined.
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Configuring OpenlL Tablets Web Services via JNDI Connection

This section describes how to configure JNDI connection when OpenL Tablets Web Services is started under
Apache Tomcat. Before configuration, ensure that resources are set up in the context.xml file as described in
Configuring Resources for JNDI Context.

To configure Openl Tablets Web Services via JNDI connection, proceed as follows:

1. Openthe WEB-INF\classes\application.properties file

2. Set the following properties with the following values:

production-repository.factory =
org.openl.rules.repository.db.DatasourceDBRepositoryFactory
production-repository.uri = java:comp/env/jdbc/deploymentDB

3. Change the URL value for production-repository.uri according to the appropriate database as described
in the URL value according to the database type table in Setting Up Openl Tablets WebStudio with
Installation Wizard.

Note: Login and password are not required for definition inside the application.properties file while
configuring JNDI settings.

Configuring OpenL Tablets Web Services via AWS S3 Connection

This section describes how to configure an AWS S3 connection when OpenL Tablets Web Services is started
under Apache Tomcat.

To configure Openl Tablets Web Services via an AWS S3 connection, proceed as follows:

1. Build a customized version of Web Service with dependencies on *org.openl.rules.repository.aws
v5.20.54 *:

Create a pom.xml file with the following content for this:

<?xml version="1.0" encoding="UTF-8"?>
<project xmlns="http://maven.apache.org/POM/4.0.0"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemalLocation="http://maven.apache.org/POM/4.0.0 http://maven.apache.org/maven-
v4d 0 O0.xsd">

<modelVersion>4.0.0</modelVersion>

<groupId>com.example.openl</groupId>

<artifactId>webservice-aws</artifactId>

<packaging>war</packaging>

<version>1.0-beta</version>

<properties>
<project.build.sourceEncoding>UTF-8</project.build.sourceEncoding>
<org.openl.version>5.21.5</org.openl.version>
</properties>
<dependencies>
<dependency>
<groupId>org.openl.rules</groupId>
<artifactId>org.openl.rules.repository.aws</artifactId>
<version>${org.openl.version}</version>
</dependency>
<dependency>
<groupId>org.openl.rules</groupId>
<artifactId>org.openl.rules.ruleservice.ws</artifactId>
<type>war</type>
<version>${org.openl.version}</version>
</dependency>

© 2004-2020 Openl Tablets

OpenlL Tablets 5.22 Page 36 of 55



OpenlL Tablets Installation Guide Deploy OpenL Tablets Web Services under Apache Tomcat

</dependencies>
<dependencyManagement>
<dependencies>
<dependency>
<groupId>com.fasterxml.jackson.core</groupId>
<artifactId>jackson-databind</artifactId>
<version>2.9.5</version>
</dependency>
<dependency>
<groupId>com.fasterxml.jackson.core</groupId>
<artifactId>jackson-annotations</artifactId>
<version>2.9.5</version>
</dependency>
<dependency>
<groupId>commons-codec</groupId>
<artifactId>commons-codec</artifactId>
<version>1.11</version>
</dependency>
</dependencies>
</dependencyManagement>
</project>

2. Add the following properties to the application.properties file:

production-repository.factory = org.openl.rules.repository.aws.S3Repository
production-repository.bucket-name = yourBucketName
production-repository.region-name = yourS3Region
production-repository.access-key = yourAccessKey
production-repository.secret-key = yourSecretKey
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5 Install Openl Tablets WebStudio and OpenlL
Tablets Web Services on WebSphere Application
Server

This section explains how to install OpenL Tablets WebStudio and OpenL Tablets Web Services on WebSphere
Application Server. The following topics are included:

e Prerequisites
e Setting Up JVM Options for WebSphere Application Server

e Preparing Openl Tablets WAR Files

e Deploying Openl Tablets Web Applications on WebSphere Application Server
e Configuring Settings for JDBC Connection

e Configuring Settings for JNDI Connection

e Configuring Microsoft Excel Settings for WebSphere Application Server

5.1 Prerequisites

Before deploying OpenL Tablets WebStudio on WebSphere Application Server, IBM WebSphere Application
Server v. 8.5 or later must be installed on the user’s local machine, or users must be granted access to a
WebSphere Application Server instance with logon that has appropriate permissions to configure JVM options.

For more information on how to install IBM WebSphere Application Server, see Oracle online documentation,
section Installing and Configuring WebSphere 8.5 at
http://docs.oracle.com/cd/E24902 01/doc.91/e23435/inst config was85 win.htm

IMPORTANT! When defining the Shared Resource Directory during the installation process, the path to the
directory must be specified without spaces. Otherwise, Openl Tablets WebStudio fails.

5.2 Setting Up JVM Options for WebSphere Application
Server

To set up JVM options for WebSphere Application Server, proceed as follows:

1. In WebSphere Application Server Console, navigate to Servers/ServerTypes/WebSphere Application
Servers.

The server appears in the right pane.
2. Inthe right pane, click the server name.
The default value is serverl.
Locate the Server Infrastructure area and expand the Java and Process Management node.
Click Process definition.
In the upper right part of the window, click the Java Virtual Machine link.
In the Initial heap size text box, enter 256.

No g sMw

In the Maximum heap size text box, enter 1024.
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8. Inthe Generic JVM Arguments, add the following line:

-XX:+UseParallelOldGC -XX:PermSize=128m -XX:MaxPermSize=384M -
Dclient.encoding.override=UTF-8

9. Click OK.

10. In the Message window which appears in the top of the form, click Save directly to the master
configuration to save changes.

11. Restart WebSphere Application Server.

5.3 Preparing Openl Tablets WAR Files

This section describes how to configure OpenlL Tablets WebStudio and Web Services WAR files. Proceed as
follows:

1. Locate http://openl-tablets.org/downloads.
Click the appropriate OpenL Tablets WAR link.
Save the file in a temporary folder.

Open the downloaded WAR file as a ZIP archive.

In the \wEB-INF\1ib\ folder, remove the following JAR file:
jboss-transaction-api 1.2 spec-1.0.0.Final.jar

6. Save the WAR file.

o~ D

5.4 Deploying OpenL Tablets Web Applications on
WebSphere Application Server

This section describes how to deploy OpenL Tablets WebStudio and OpenlL Tablets Web Services on WebSphere
Application Server and includes the following topics:

e Deploying OpenL Tablets WebStudio on WebSphere Application Server
e Deploying OpenlL Tablets Web Services on WebSphere Application Server

Deploying OpenL Tablets WebStudio on WebSphere Application Server
To deploy OpenL Tablets WebStudio on WebSphere Application Server, proceed as follows:

1. Ina browser, enter the following URL:
https://localhost:9043/ibm/console
This is a default port for local installation. The WebSphere Application Server Console window appears.
2. Navigate to Applications / Application Types / WebSphere enterprise applications.
3. Inthe top line tool bar, click the Install button.
4. Inthe Path to the new application area, select the modified OpenL Tablets WebStudio WAR file.
The Local file system option is selected by default.
5. Click Next till Step 2.
6. Inthe Step 2: Map modules to servers page, select the check box on the left to the file name and click Next.

7. Inthe Step 3: Map virtual hosts for Web modules page, select the check box on the left to the file name and
click Next.
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8. In the Step 4: Map context roots for Web modules page, in the Context Root text field, enter /webstudio
and click Next.

9. Click Finish to complete.
10. When the installation process is complete, click the Manage Applications link.
11. In the next window, in the list of applications, click the OpenL Tablets WebStudio WAR file link.
12. In the next window, locate the Detail Properties area and click the Class loading and update detection link.
13. In the next window, select the following radio buttons:
e C(Classes loaded with local class loader first (parent last)
o Single class loader for application
14. Click OK to finish.
15. In the next window, click the Save directly to the master configuration link.
Now the OpenlL Tablets WebStudio application is installed and started. If not, start the application.
16. Run Openl Tablets WebStudio by entering http://localhost:9080/webstudio/ in a browser.

The Welcome to OpenL Tablets WebStudio Installation Wizard window appears allowing to set up the
application as needed. For more information on the application setup, see Configuring External User
Database, Setting Up Openl Tablets WebStudio with Installation Wizard and OpenL Tablets WebStudio
Customization.

Deploying OpenL Tablets Web Services on WebSphere Application Server

To deploy OpenlL Tablets Web Services on WebSphere Application Server, complete steps 1-16 described in
Deploying Openl Tablets WebStudio on WebSphere Application Server.

For more information on configuring the OpenL Tablets Web Services settings, see Deploy OpenL Tablets Web
Services under Apache Tomcat.

5.5 Configuring Settings for JDBC Connection

To configure Openl Tablets WebStudio or OpenL Tablets Web Services, prepare war files as described in
Preparing OpenL Tablets WAR Files and then do one of the following:

e Configuring Openl Tablets WebStudio via JDBC Connection
e Configuring OpenL Tablets Web Services via JDBC Connection

5.6 Configuring Settings for JNDI Connection

This section describes configuring JNDI connection settings and includes the following topics:

e Configuring Global JNDI Context
e Configuring Local JNDI Context

Configuring Global JNDI Context
To configure global JNDI settings, perform the following actions:

e Configuring Authentication Data
e Defining a JDBC Provider
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e C(Creating a Data Source

Configuring Authentication Data

To configure authentication data, proceed as follows:

1. Open the https://localhost:9043/ibm/console login page.

2. Select Security — Global > Authentication > Java Authentication and Authorization Service.
3. Click J2C authentication data.

4. Inthe window that appears, click New, fill in all mandatory fields, and click Ok and Save.

Global security

Global security > JAAS - 12C authentication data = Newr...

Specifies a list of user identities and passwards for Java(TM) 2 connector security to use,

General Properties

# Alias
|MyOrac|e2

# User ID
[wLvmKowvA

# Password

Dezcription

Apply | oK | Reset | Cancel |

Figure 17: Setting up global security in WebSphere

Defining a JDBC Provider

To define a JDBC provider, proceed as follows:

1. Inthe Resources section on the left panel, click JDBC providers and select the appropriate scope of the
current user and server.

= Scope: Cell=WLYNKOVANode0d1Cell, Node=VLYNKOVANodeD1l, Server=serverl

Scope specifies the level at which the resource definition is visible. For detailed information on what scope is and how
it works, see the scope settings help.

‘ Node=VLYNKOWVANcd=01, Server=serverl Izl

Figure 18: Configuring scope for new JDBC provider

2. Click New to create a provider.

3. Select the required Database type, for example, Oracle, Provider type, for example, Oracle JDBC Driver,
Implementation type, for example, Connection pool data source, enter the name, and click Next.
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Create new JDBC provider

Set the baszic configuration valuez of a JDBC provider, which encapsulates the specific
vendor JDBC driver implernentation classes that are required to access the database, The
wizard fills in the narme and the description fields, but you can type different values,

Scope
|cells:VLYNKO‘JANDdEDlCEII:nndes WLrMEOVANodeDl  servers: serverl

% Databaze type

| Oracle

# Provider type
| Oracle JDBC Driver |E|

# Implermentation type
| Connection pool data source IZ|

# Mame
|Orac|e JDBC Driver2

Figure 19: Creating a new JDBC provider

4. Inthe next page, fill in the location to appropriate driver for the Oracle database as described in the
following example excluding the name of library itself:

Directory location for "ojdbcs.jar” which is saved as WebSphere variable ${ORACLE_JDBC_DRIVER_PATH}

||::'1

Figure 20: Defining the location of appropriate database lib

5. Click Ok and Finish on the last installation page.
6. Click Save to complete and save provider.

Creating a Data Source
To create a data source, proceed as follows:
1. Inthe Data source section, select the appropriate scope of the current user and server.

2. Click New.
3. Provide basic data source information, such as data source name and JNDI name.

Scope
|ce||5 WLYMEOVANodeDl Cellinodes WLvHNKOVANode Ol servers i serverl

4 Data zource name
|M','Orac|eD52

4 IJMDI name
|n:-rac|eJNDI

Figure 21: Configuring a new Data Source

4. Click Next.
5. Select a JDBC provider and click Next.
6. Define URL of the appropriate data user to connect to.
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An example is jdbc:oracle:thin:@localhost:1521:orcl.

7. Ensure that the Use this data source in container managed persistence (CMP) option is cleared and click
Next.

8. Define authentication settings.

Setup security aliases

Select the authentication values for this resource,

Component-rmanaged authentication alias
| WLFMESWANode 0l My Sracle2 |EI

Mapping-configuration alias

[mone)

Container-rmnanaged authentication alias
| VLYMEOWANadeD 1/ MyDracle 2 Izl

Mote: v¥ou can create a new 12C authentication alias by acceszsing one of the following
links., Clicking an a link will cancel the wizard and vour current wizard selections will be lost,

Global 12C authentication alias
Security dormains

Figure 22: Configuring Data Source

9. Click Next and Finish and then save the created configuration.

When the JNDI connection is created and saved, a user can connect to the database where deployment
repository will be stored. The database URL, that is, JNDI name, must have a short version of it without
prefixes java:comp/env/jdbc/ because it is configured as a global JNDI context.

Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Name: * Deployment
Type: # Database (JNDI) B
URL: * oracleJNDI

Figure 23: Connecting to the database in OpenL Tablets WebStudio via global JNDI context

To start OpenlL Tablets WebStudio on WebSphere, proceed as described in Deploying OpenL Tablets WebStudio
on WebSphere Application Server.

To start OpenlL Tablets Web Services on WebSphere, proceed as described in Deploying OpenL Tablets Web
Services on WebSphere Application Server.
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# In case of DB via JNDI this property defines how to access i1t
production-repository.factory = org.openl.rules.repository.factories.IndiDBRepositoryFactory
production-repository.uri =oraclelNDI

Figure 24: Configuration settings for OpenlL Tablets Web Services via global JNDI context

Configuring Local JNDI Context

Typically, Enterprise JavaBeans (EJB) does not use the global name to look up the data source while configuring
JNDI connection in an enterprise application, such as WebSphere. Instead, EJB uses a logical JNDI name that is
mapped to the global JNDI name of the data source. Proceed as follows:

1. To map a logical JINDI name to the global JNDI data source name, declare a resource reference in the

deployed application \WEB-INF\web.xm1l file as follows:

<resource-ref>
<description>Resource reference to a factory for java.sql </description>
<res-ref-name>jdbc/JINDIName</res-ref-name>
<res-type>javax.sqgl.DataSource</res-type>
<res-auth>Container</res-auth>

</resource-ref>

The value of the <res-ref-name> tag is a logical JNDI name EJB uses to look up the data source. The value of

the <jndi-name> tag is a global name of the data source to which the logical name is mapped.

2. When the resource reference settings are added, save the file and repack the application.

3. Start deploying OpenlL Tablets WebStudio or OpenL Tablets Web Services as described in Deploying OpenL
Tablets WebStudio on WebSphere Application Server, steps 1-5.

4. Inthe Map resource references to resources window, in the Set Multiple NDI Names list, select Target
Resource JNDI Name and click Next.

Map resource references to resources

Each rescurce referengz that is defined in your application must be mapped to a rescurce.

Set Multiple JNDI Names ~ | Modify Resource Authentication Method... Extended Properties...
jdbc/DefaultE1BTimerDataSource
oracleDBE2
jdbc/IpbDB
DefaultDatasource
oracleINDI Rescurce . : ’
Target Resource JNDI Name Login configuration
Reference
Resource
authorization:
oracleINDI i
COpenl Web vis.war, WEB- idbe/oraclelNDI | Container
Service INF/web.xml ¥ M R e
method:
MNane

Figure 25: Configuring mapping for a local JINDI context

5. Complete configuration as described in Deploying OpenL Tablets WebStudio on WebSphere Application
Server, steps 7-16.
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5.7 Configuring Microsoft Excel Settings for WebSphere
Application Server

The Open in Excel functionality does not work if WebSphere Application Server 8.5 is used under default
settings. Execute configuration changes described in Configuring Microsoft Excel Settings for Apache Tomcat.
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6 Install Openl Tablets WebStudio and OpenlL
Tablets Web Services on JBoss Application Server

This section explains how to install OpenL Tablets WebStudio and OpenL Tablets Web Services on JBoss
Application Server in a standalone mode.

The following topics are included:

e Deploying OpenL Tablets WebStudio on JBoss Application Server

e Deploying OpenL Tablets Web Services on JBoss Application Server
e Setting Up a JDBC Connection

e Setting Up a JNDI Connection

6.1 Deploying OpenL Tablets WebStudio on JBoss
Application Server

To deploy OpenlL Tablets WebStudio on JBoss Application Server, proceed as follows:
1. Rename the Openl Tablets WebStudio war file to webstudio.war.
2. Copy webstudio.war to the <JBoss home directory>\standalone\deployments directory.

3. Ifthe auto-deploy-zipped attribute is set to true in the standalone.xml file, manually create an empty
file webstudio.war. dodeploy.

Run the <dBoss home directory>\bin\standalone.bat file.

Verify that the webstudio.war.deployed marker is generated.

To run Openl Tablets WebStudio, in a browser, enter http://localhost:8080/webstudio/.
The Welcome to OpenlL Tablets WebStudio Installation Wizard window.

© N o v b

Set up the application as required.

6.2 Deploying OpenL Tablets Web Services on JBoss
Application Server

To deploy OpenL Tablets Web Services on JBoss Application Server, proceed as follows:

6. Rename the Openl Tablets Web Services file to webservice.war.

7. Copy the webservice.war file to the <dBoss home directory>\standalone\deployments directory.
8. Runthe <JBoss home directory>\bin\standalone.bat file.

9. Verify that the webservice.war.deployed marker is generated.

10. To run OpenL Tablets Web Services, in a browser, enter http://localhost:8080/webservice/.
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6.3 Setting Up a JDBC Connection

To set up a JDBC connection for OpenL Tablets WebStudio, proceed as follows:

1.

2
3
4.
5

Download a required JDBC driver.

Run < JBoss home directory >\bin\standalone.bat.

Run JBoss command line client <dBoss home directory>\bin\jboss-cli.bat.
In Jboss-cli:, connect to the server using the connect command.

In Jboss-cli:, add a module using the following command:

module add --name=<module name> --resources=<path to the driver> --
dependencies=javax.api, javax.transaction.api

An example of the MySQL driver copied to the <JBoss home directory>\bin directory is as follows:

module add --name=org.mysgl --resources=mysqgl-connector-java-8.0.11.jar --
dependencies=javax.api, javax.transaction.api

To prepare *.war files for deployment, in the META-INF\jboss-deployment-structure.xml file, add the
following structure:
<dependencies>

<module name="<module name>" export="true" />

</dependencies>

For webservice.war, in the application.properties file, specify a connection to the database as follows:

production-repository.factory = org.openl.rules.repository.db.JdbcDBRepositoryFactory
production-repository.uri = jdbc:mysqgl://localhost/deployment-repository

Ensure that the application.properties file is “visible” at the JBoss launch location.

For example, if the application.properties file is located in JBoss home directory, JBoss must be run
from this directory via the bin\standalone.bat command.

Configure a JDBC connection for OpenL Tablets WebStudio as described in Configuring OpenlL Tablets
WebStudio via JDBC Connection.

6.4 Setting Up a JNDI Connection

To set up a JNDI connection settings for OpenlL Tablets WebStudio, proceed as follows:

N o v s~ w N RE

Copy a database driver to the <gBoss home directory>\ standalone\deployments\ directory.
Run the <dBoss home directory>\bin\standalone.bat file.

In a browser, enter http.//localhost:8080/.

Click Administration console.

Click the Configuration link.

Select Subsystems > Datasources > Non-XA.

Click Add.
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Home  Deployments = Configuration Runtime  Access Control Patching

Configuration Subsystem (30) Type Datasource %
Subsystemns > Q Non-XA > ExampleD5

Interfaces ICA KA >

Sacket Binding Datasources *

Paths

Resource Adapters >

System Properties Ma ’

Transactions

EB3

Figure 26: Configuring a JNDI connection
8. Inthe Create Datasource window, select a data source and click Next.
9. Enter the data source name and JNDI name and click Next.

10. Switch to the Detected Driver tab.

Create Datasource « R
Step 2/3: JDBC Driver 3
Select one of the installed |DBC drivers. If you do not see your driver, make sure
that it is deployed as a module and properly registered.

Specify Driver etected Driver

Name
h2
mysql-connector-java-8.0.11.jar
1-6of B
Cance « Back Next
4

Figure 27: JDBC Driver collection
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11. Select a JDBC driver and click Next.

12. Specify database connection settings and click Next.
13. To test the JDBC connection, click Test Connection.
14. Click Next and then click Finish.

15. For webservice.war, in the application.properties file, specify the connection to a database as follows:

production-repository.factory =
org.openl.rules.repository.db.DatasourceDBRepositoryFactory

production-repository.uri = <JNDI Name>

16. Configure a JNDI connection for OpenL Tablets WebStudio as described in Configuring Settings in OpenL
Tablets WebStudio.
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7 Openl Tablets WebStudio and Web Services
Integration

This section describes how to set up OpenL Tablets WebStudio and OpenL Tablets Web Services integration and
enable backward compatibility and includes the following topics:

e Deploying Rules to the Production Server
e Integrating Openl Tablets WebStudio and OpenlL Tablets Web Services via Jackrabbit Repository
e Integrating OpenL Tablets WebStudio and OpenL Tablets Web Services via Database Repository

7.1 Deploying Rules to the Production Server

After integration any changes can be made in user’s rule in OpenlL Tablets WebStudio, and then the project must
be saved and redeployed. These changes immediately affect the rule represented as web service. During
development, rules are stored in the file system of the development server. When development is finished, rules
can be deployed to the production server as follows:

1. Openl Tablets WebStudio sends the rules project to one of the following locations depending on the
integration type:
e Repository Engine, that is, Jackrabbit web application, using the RMI or WebDAV protocol,
in case of integration via Jackrabbit repository.
e database repository, using the JDBC driver for connection, in case integration via database repository.
2. The rules are saved on the production server.
3. Openl Tablets Web Services detects a new version of the deployed rules and starts using it.
The following diagram illustrates the OpenlL Tablets WebStudio and OpenL Tablets Web Services integration:

Application Instance Application Instance

CpenlL Tablets WebStudio Deployment

A ;
Repository Web Services

| OpenL Tablets

R

OpenL Design
Working Repository
Directory

Figure 28: Openl Tablets WebStudio and OpenL Tablets Web Services deployment
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7.2 Integrating OpenL Tablets WebStudio and OpenlL
Tablets Web Services via Jackrabbit Repository

This section describes how to set up an RMI-integrated environment that enables work with business rules from
Openl Tablets WebStudio and launch these rules as OpenL Tablets Web Services.

In the following example, OpenL Tablets WebStudio must be run under Tomcat.

All sources related to JCR repository can be downloaded at http://openl-tablets.org/downloads, the Repository
(ZIP file) link. The repository package is a ZIP file containing repository server, configuration files, and an empty
JCR repository.

Proceed as follows:

1. Copythe openl-tablets-remote-repository-server-X.x.X.war file from the repository package into
\<TOMCAT_ HOME>\webapps.

2. Copy the deployment-repository folder into the <oPENL HOME> folder.
By default, the repository folder name is deployment-repository. Settings described further use this name.
3. In\<openl-tablets-remote-repository-server-X.X.X.war>\jackrabbit\bootstrap.properties, set

up repository settings as follows:
repository.home=<OPENL HOME>/deployment-repository
repository.name=deployment-repository
# RMI Settings
rmi.enabled=true
rmi.port=1099
rmi.host=0.0.0.0
4. For Tomcat version 8.0.10-8.0.23, open the \<openl-tablets-remote-repository-server-
X.X.X.war>\WEB-INF\web.xml file and in the Repository Startup Servlet and Repository Servlet sections,
inside the <init-param> tag, modify <param-value> and <param-value> as follows by adding slash symbol:
<init-param>
<param-name>bootstrap-config</param-name>
<param-value>/jackrabbit/bootstrap.properties</param-value>

5. Inthe \<openl-tablets-remote-repository-server-X.X.X.war>\jackrabbit\bootstrap.properties
file, update the repository.config property as follows:
repository.config=/jackrabbit/jackrabbit-repository.xml

6. Set up Openl Tablets Web Services as follows:

1. Openthe \<TOMCAT_ HOME>\webapps\<ws project name>\WEB-INF\classes\
application.properties file.

2. Ensure production-repository.uri is correct.
7. Torun Openl Tablets WebStudio, in a browser, enter http://localhost:8080/<webstudio war file name>.

Set up the appropriate design and deployment repositories settings in OpenL Tablets WebStudio
administration.

In this example, deployment repository settings must be as follows:

Note: If Deployment repository is created in OpenL Tablets version older than 5.20, the Version in deployment name
check box must be selected for backward compatibility.
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Deployment Repositories

Deployment storages of deployed rule projects where solution applications use them.

Narme: * Deployment
Type: * Remote - RM v
URL: * Mocalhost: 1089/deployment-repository

Secure connection

version in deployment name

Figure 29: Deployment repository settings for RMI connection

7.3 Integrating OpenL Tablets WebStudio and OpenlL
Tablets Web Services via Database Repository

This section describes an alternative way of how to set up an integrated environment that enables work with
business rules from OpenL Tablets WebStudio and launch these rules as OpenlL Tablets Web Services. To set up
Openl Tablets WebStudio and OpenL Tablets Web Services integration using the database as storage for
deployment repository, proceed as follows:

1. Install OpenL Tablets WebStudio and OpenL Tablets Web Services on the same application server.
2. Connect OpenL Tablets WebStudio to the database to store deployed projects as described in Setting Up
Openl Tablets WebStudio with Installation Wizard.

3. Configure OpenL Tablets Web Services for a database data source as described in Configuring Openl Tablets
Web Services for a Database Data Source.
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8 Troubleshooting Notes

If OpenL Tablets WebStudio is deployed under Tomcat in the Unix/Linux environment, consider the following
troubleshooting recommendations:

1.

Before starting Tomcat under Linux, make sure that no Java processes are running:

sudo ps -A | grep j

If found, the process name and number are displayed.

If any Java process is running, stop it as follows:

kill -9 <process number>

Make sure that port 8080 is available as follows:

sudo netstart —-an | grep 8080

Run Tomcat under Linux as follows:

<TOMCAT HOME>/bin/startup.sh

If the command not found error appears, mark the . sh file as an executable script as follows:
chmod +x startup.sh

If the Permission denied or The BASEDIR environment variable is not defined correctly error is displayed,
make all . sh files in the bin folder executable as follows:

chmod 777 *.sh

Verify that all . sh files in the bin folder are executable as follows:

1ls -1la

Run Tomcat as follows:

<TOMCAT HOME>/bin/startup.sh
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9 Frequently Asked Questions

This section provides the most common questions and answers related to the OpenL Tablets installation
procedure. For more information on working with Java, Tomcat, and other third party software, see the

corresponding sites of the software manufacturers.

Frequently Asked Questions

#  Question Answer
1 How can | check if Java is installed on my PC? Proceed as follows:
1. Open Start > Control Panel.
2. Perform either of the following:
e For Windows XP, double click Add or Remove Programs.
e For Windows 7/Vista, click Programs > Programs and
Features.
3. Look through the list for Java(TM)... or Java(TM) Update...
items. If any is present, Java is installed on your PC.
2 During Java installation, the page for Java No, it is optional. You can close the registration page.
registration appears. Do | have to register Java?
3 How can | check which version of Java is Open the Verify Java Version page and click the Verify Java
installed on my PC? Version button.
In a few seconds a new page appears where you will find the
message similar to the following one: Your Java version: Version 6
Update 26.
4  How can | see the error message in the Tomcat  Proceed as follows:

console that appears when | start Tomcat? The
error screen disappears too quickly.

1. Click Start > Run.
2. Llocate the <TOMCAT HOME>\bin folder.
3. Select catalina.bat and enter run in the command line.

© 2004-2020 Openl Tablets
OpenlL Tablets 5.22

Page 54 of 55


http://java.com/en/download/installed.jsp

OpenlL Tablets Installation Guide Appendix: Official Docker Images for OpenL Tablets

Appendix: Official Docker Images for Openl Tablets

OpenlL Tablets supports Docker containers. The following table provides links to the Docker images for OpenL
Tablets:

Docker images for OpenL Tablets

Openl Tablet resource Reference

Openl Tablets Web Services https://hub.docker.com/r/openltablets/ws/

Openl Tablets WebStudio https://hub.docker.com/r/openltablets/webstudio/
Openl Tablets demo https://hub.docker.com/r/openltablets/demo/
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